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Initial BDMS Setup on Your PC 
New to document imaging and the BDMS software?  Here are the steps to get you started: 

1. Synchronize your BDMS and Banner password by going into a Banner form, such as 
FGAJVCD, and open up the BDMS- display document button.   

You should enter a document number (any document number) into the “Document Number” 
field.  If you do not, it causes a query to be executed for all items and this could take some time. 

 
This will open up a browser window and connect to the BDMS server.  You should see an import 
new page screen like the one shown below.  The system has now synchronized your password.  
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Do this for each Banner instance, i.e. BPRD, BTST, etc.    

If this is the first time you have accessed BDMS on your computer – proceed to step 2, otherwise 
you are ready to move on to querying/processing.  Stay in BDMS for the next step.   

 
2. Verify the installed components of the BDMS software on your computer.   

This only needs to be done once per computer you use.  If you have already done these steps on 
this computer – you do not need to repeat them. 

While on the Query Results or Query Criteria page, select the “Application List” icon from the 
menu 

 
This will bring up all the applications you have access to in BDMS. (See the appendix for a 
definition and listing of BDMS applications) 

 
Go the Help menu on the Application page in BDMS and click on “Check Installed Components” 
under “Help” 

 
This will open a window that will display the available components as well as a listing of what the 
status is for each of these components.  Should you get an error message on this screen – there 
could be a message at the very top of the page indicating a request to install some active-x 
control.  Right click on this message and select install control – then click yes on any subsequent 
messages you may see.  When complete – the list should automatically complete. 
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Confirm the current install status shows “Installed” and lists the same version as is described in 
the application listing above.  In the example depicted, the “Scanning Component” is listed as 
“v6.5” in both the component list and the current installed status.   

If you do not have all the component’s listed or there are different versions installed than are 
listed in the component list, you need to install the component.  Click on the blue icon next to the 
component you wish to install from the list at the top of the menu.  This will download and install 
the selected component.  As with most windows installs, you may have to click the “yes” button 
several times for this to complete.  

All four items need to say “Installed” and reference the correct version number when complete.   

Once this is achieved, click on the “Close” button at the bottom of the window.  This will return 
you to the “Applications List”. 

3. Verify your user settings. The User Settings button allows you to control the way 
documents are retrieved, displayed, exported, and printed in BDMS. The changes you make to 
your settings will not affect other users.  

The items listed below are recommended settings for all users and should be completed before 
you use BDMS to provide a consistent view of documents.  If this is not completed, the view you 
have of the BDMS screens and or documents may not look like what is in this document. 

You may change other settings based on your individual needs, as you use the product. 
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From the “Application List” screen click on the User Settings icon, this can also be selected from 
the “Edit” menu item. 

 
There are several menus available with multiple selections per tab. There are recommended 
changes to only two of the tabs, the first tab, “Search/Result Set”, and the fourth tab, “Interactive 
Viewer”. 

 
On the “Search/Results Set” tab: 

• select the “Display Documents in Separate Popup Window” checkbox 

 
Note that this will gray out the second option on this tab. 
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On the “Interactive Viewer” tab: 

• select the “Enable Interactive Viewer” checkbox.  

• select the “Use Keyview To Display Foreign Files” checkbox  

 
Other items on each tab may be selected as you choose. 

When finished, click the “Save” button in the lower right hand corner of the window to keep the 
setting you have just made. 

 

Additional information available  
General SunGard documentation on the USNH Gateway webpage 
        http://www.usnhgateway.org/  >> Documentation >> Xtender 

 
Detailed UNH BDMS training is available Xtender training class through UNH IT –  

http://it.unh.edu/ >> Software >> Training 

 
To Sign Up 

http://www.usnhgateway.org/
http://it.unh.edu/
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Overview - The Steps of the Business Process  
 

The process of scanning, saving, indexing, and finalizing journal voucher documentation is made up of 
8 basic steps.  We will go into detail for each of the steps in the process further along in the document.  

1. Scan a paper document or locating an existing file. 

2. Import into BDMS. 

3. Perform quality control review. 

4. Index the document(s). 

5. Save indexed document. 

6. Re-orient pages as required 

7. Remove source document(s) from shared folder(s).  

8. Keeping the paper documents. 

Scanned 
Document

Saved
Document

Available in 
BDMS via 

Banner 
Forms

Import

Quality 
Review

Index

Save
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1. Imaging Documents 
There are several methods of associating documentation with Banner documents. 

A. Using a Multi-Function Device (MFD) or shared scanner to create a file for import: 
a. as an individual document 
b. as a batch 

B. Using existing source documents like an .xlsx, .docx, email, or a PDF file. 

C. Scanning directly into BDMS 

We will discuss options A and B here.  Option C requires a personal scanner connected to your 
desktop.  This will not be covered here.  Additional information on this and other functions is 
available in the general documentation at the gateway page and/or sign up for IT training.  (see 
additional information for links)  

A. Using an MFD or shared scanner to create a file for import: 
This requires your MFD to be properly configured.   

If you are uncertain how to do this, please contact the vendor for assistance.   

This discussion is based on using an HP-4730.  The process is similar for the C-353. 

Some of the options that need to be set up: 
i. Create a shared network folder 
ii. Enable Send to Folder option 
iii. Set default settings for copy color type, DPI, and file type 
iv. Various security settings that authorizes users 

Using other MFDs or a shared scanner will be similar.     

The materials scanned may be for a single document or for a group of documents (batch).  If 
you prefer, you can scan the materials for each individual document into a separate file-folder 
on the server.  Alternatively you may scan the materials for a number of transactions into a 
single large item which you will continuously import until all the materials have been 
associated with transactions. 

1. Place your documents face up in auto document feeder or face down on the glass plate if 
an auto feeder is not available.  This is just like you are making regular copies. Make sure 
you account for changes in paper size and double sided 
copies.   

2. Touch the Folder button (on the right side of screen).   

3. Select a folder from the list.  
(\\Louise.USNH.edu\Imaging\deptname\JournalVoucher) 

4. Touch the FileName: button and type a file name for your 
document.  

5. Touch the OK button to return to the Folder screen. 

6. Press the Start button to send.  Document is “scanned” and saved as a PDF with the 
desired file name.   
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7. This results in a single PDF file that provides the documentation for 1 or more journal 
voucher(s). 

B.   Using existing source documents like an .xlsx, .docx, email, or a PDF file. 
Many types of documents that you work with on a daily basis may be used as supporting 
documentation in their normal state.  That is you can use an excel file saved as a functioning 
.xls, .xlsx etc. directly to BDMS in support of a transaction. 

All Microsoft Office files from version 10 back through 2003 are compatible with BDMS.  Text 
files such as those created with notepad or WordPad or saved email need to be saved as text 
files to be imported.  (see email section in the appendix). 

Adobe files (.pdf which is what is generally created by the MF devices) can be used and read 
directly in BDMS. 

To make the process more consistent, you may want to move/copy any files you have which 
will be used for support into the same directory as you are currently storing the scanned files 
you created in step A above (\\Louise.USNH.edu\Imaging\deptname\JournalVoucher). 

2. Import file(s) into BDMS and associating with the appropriate transaction 
These files may be existing PDFs, xlsx, docx,  etc files or images of those documents just scanned. It 
is recommended that the directory \\Louise.usnh.edu\usnh\JVimages be used for all your data 
files for consistency. 

The documentation can only be associated with an already existing transaction in Banner.  If the 
transaction does not yet exist, and therefore has no document number in Banner yet, the 
documentation cannot be fully associated with transaction. 

You may begin the process from many different forms.  The document number you are focusing 
on must be on the page you are starting from.  Some examples are below: 

 

Journal Vouchers 
(JV) Invoices (INV) General Forms 

FGAJVCD FAAINVE FOAUAPP 
FGAJVCQ FAIINVE FOIDOCH 
FGAJVCM  FGATRND 

   
 

See Appendix for more details. 

Regardless of the form you start from – each of the steps are the same.  For this document, we 
will begin from FOAUAPP. 

file://Louise.usnh.edu/usnh/JVimages
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The fifth line is highlighted as I have clicked in that row.  This indicates the transaction I am 
interested in.  There are two buttons on the top menu (circled above) which relate to BDMS.   

Here is what the form looks like if you start importing from FGAJVCD.   
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Regardless of which form you start from you will be choosing the big plus icon, BDMS – Add 
Document to begin the import process.   

 

A. When there is documentation for only a single document in a file  
 
Begin the process by clicking on the BDMS – Add Document button as shown above.  BDMS will open 
in the import screen shown below.   

1. Click the New Page button. 

 

 
 

 
2. Follow the menu path: New Page >> Import File >> Append.  

3. In the Import File box, select the file you wish to import and click the Open button.  
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The document is now imported and but needs to be compared to the source documents to 
ensure all pages are accounted for, it is in the correct order, and fully legible.   

   

B. When there is documentation for multiple documents in a file (batch) 
 
Begin the process by clicking on the BDMS – Add Document button as shown above.  BDMS will open 
in the import screen shown below.   

1. Click the New Page button. 

 

 
 

 
2. Follow the menu path: New Page >> Import File >> Append.  

3. In the Import File box, select the file you wish to import and click the Open button.  
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The document is now imported and but needs to be compared to the source documents.  This 
document will eventually be split into multiple document numbers.  You will complete the first 
document index and then go back into Banner, choose your Banner form, your Document ID 
and then BDMS - Add document.   The remaining pages of the original PDF will be waiting in 
BDMS for you to index!   

C. With multiple files or multiple types of files 
 
Begin the process by clicking on the BDMS – Add Document button as shown above.  BDMS will open 
in the import screen shown below.   

1. Click the New Page button. 

 

 
 

 
2. Follow the menu path: New Page >> Import File >> Append.  

3. In the Import File box, select the files you wish to import.  Select multiple files by holding down 
the Ctrl key and doing a right mouse click if you are going to open multiple files from this 
location.   
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4. You can repeat steps 1 -3 for as many files as you need to import for all the necessary pages in 

this documentation package.  The number of pages that have been imported is located at the 
bottom left of the screen.   

 
5. Once all the pages are present you can begin the quality control review.   

 

3. Performing Quality Control Review 
All documentation must be reviewed for quality control purposes.  Quality control has 6 elements 
that must separately be verified.  This function is vital since there will ultimately be no paper.   

1. All scanned documents must be at least 300 DPI and in black and white.   

2. All pages in the documentation package must be present.  Make certain both sides of your 
document were scanned.   

3. All pages need to be oriented correctly.  The top of the image must be the top of the page 
regardless of the page’s orientation, i.e. portrait or landscape.  If any page does not meet this 
requirement please note which pages need to be addressed.  You can correctly reorient the 
page once the document has been indexed.   See section 6 for the specific instructions to 
reorient a page once it has been indexed.   

4. Pages must be related to the document that is being supported 

5. All pages should be clearly legible.  If there are multiple pages in the document then you will 
see the previous and next page arrows.  This allows you to go to each page easily to do your 
quality control.  

  
6. If any of the above criteria are not met, the issue should be rectified before you continue.  

You may need to rescan the entire document, add pages from an additional file, or re-orient 
the pages after indexing.   
• If you need to rescan the entire document,  

• exit your browser window without saving your work.   
• The original scanned PDF should be deleted at the same time to eliminate any 

confusion.  See the specific instructions for deleting the source documents PDFs at the 
end of this section on page 20.   

• Start the process once again correcting the problem 

4. Indexing 
1. Once you have a document open and quality control has been completed, click the New button.  
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2. The Index Name/Field Value screen appears. 

Note: The index fields you see depend on the application you are in.  For a JV: 

 
Index name Description 
Document ID Banner Document ID - Begins with a J for JVs 
Banner Doc Type Drop down menu with 7 options –Use JV 
Document Type Drop down menu with 12 options – Use JV 
Transaction Date Date of Document ID Transaction 
Vendor ID USNH ID 
Vendor Name Vendor last name 
First Name Vendor first name 
PIDM Vendor ID number 
Routing Status An automated input field 
Activity Date This field is auto filled with current date 
Batch ID An automated input field 
Security Enter the word all 

3. Confirm and enter the index terms. For Journal Vouchers the following fields need to be filled 
in: Document ID, Banner Doc Type, Document Type, Transaction Date, Activity Date, and 
Security.  Some information will be presented that are specific to the document in question.   

5. Save indexed document 
1. When you have entered and verified index terms, click the Save button.   You may get the 

following message.  Click OK. 

Enter – Journal Voucher 

Enter – All 
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2. When you click Save, you may see an error message, indicating that a unique key violation has 

occurred. This means that documentation for the document number already exists.  
a. If you do not see this error, continue to step 4.  
b. If you see this error, please refer to the user documentation titled “What do I do about 

this Unique Key Violation?” in the appendix. 

3. The document is now imported, reviewed for quality, and indexed.  

4. If you need to re-orient any pages – continue to item 6 below. 

5. If you are finished with all your BDMS activity you can now Log out of BDMS to end your 
session. If you are completing more than one Document ID, then go back to your Banner form and 
type in the next Document number and click  BDMS – Add Document button.   

6. Reorient pages as required 
This may be needed if the document was not oriented correctly when imported.  Once the 
document has been saved you can follow this process to correct the orientation.  You cannot 
reorient documents before they have been saved and indexed!  You need the document ID to 
follow this process.   

• You can go to the document from the FGAJVCD, FGAUAPP, or other forms as appropriate.  
Enter the document number in the form and then select the BDMS – Display Document icon.   

 
  

• This will open up the document and all the associated pages.   

• If already in BDMS right click on B-F DOCS and select New Query.  
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• Type the Doc number in the Document ID field and click on Submit in bottom right corner.   

 
• This will open up the document and all the associated pages.   

 

• Go to the page that needs to be reoriented.   

• Click on the rotate right or left buttons until the orientation is correct.   

 
• Open the Page menu (open book) icon.  Use the down arrow and the path New 
Version>>Current View      
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View before revising current view: 
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View after revising the current view: 

 
Orientation is corrected. 

 
• Click on the Document index button 

 
• Click on the modify button and then save.  If you need to reorient more than 1 page in this 

document, repeat with each specific page. 

• If you close out of the document and go back in you will see 2 new icons in the tool bar.  These 
icons only show up for documents that have had their orientation changed.   

  

    
These allow you to toggle between the most recent saved orientation of the page and the 
original orientation when it was originally imported.   

7. Remove source document(s) from shared folder(s)  
Once the scanned file has been imported into BDMS it needs to be deleted from the shared 
location.  Go back into the path where the scanned documents are stored 
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(\\Louise.USNH.edu\Imaging\deptname\JournalVoucher) and delete any files that have already 
been imported to BDMS.   

This is a shared area so to keep the area cleaner all items will be removed from the file server 14 
days after the original scan date.  We believe that this is sufficient time for the necessary tasks to 
be completed; however, we will review this practice after we have been using it for a time.   

To delete a scanned source document: 

1. Right mouse click on the Start button and choose Explore.   Locate the path and folder the 
specific documents were in.   

2. Left mouse click on the document you wish to delete.  

3. A warning appears, asking “Are you sure you want to delete (the file name)?” Click the Yes 
button.  

4. The document is deleted.  

5. Close out of Explore. 

This is probably a good time to destroy any original paper copies as well.   

8. Keeping the paper documents 
1. Once you have scanned a package of journal voucher documents you need to keep this 

paperwork until all quality control work is verified.   

2. The quality control and indexing processes should be completed within 2 weeks of scanning 
your documents.   

3. Once you have completed quality control and indexed the document you will be able to go 
ahead and destroy the original source documents.   

It is up to each area to determine their own comfort level in retaining the paper they have 
scanned.  As indicated above, once the paper has been scanned, indexed and reviewed for quality 
the paper can be destroyed. 

  

file://Louise.USNH.edu/Imaging/deptname/JournalVoucher
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Modifications to existing documentation 

1. Change an index field 
You must know your document number to perform this function.   
 

1. In Banner log into the form of your choice.  

2. Enter your document number. 

3. Click on the BDMS – Display Document button. 

 

 
 

4. The documentation for this item will open up in BDMS.  (If there is no documentation in BDMS 
for this item you will see this message: 

 
At this point you can close BDMS and go back into Banner and type an existing Document ID in 
the query field and click on Submit. )   

 

5. Click the Document Index button on the toolbar.  

 
6. Click the Modify button. 
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7. Change the appropriate fields. 

Note: Some fields may be grayed out because they cannot be changed once they have been 
saved the first time.  

8. Click the Save button.  

 
9. Log out of BDMS. 

2. Adding new documentation to an existing index 
If you need to add additional documentation to an indexed document, follow these instructions 

 

1. In Banner log into the form of your choice.  

2. Enter your document number.  

3. Click on the BDMS – Display Document button. 
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4. Open the document index 

 
5. Open the Page menu (open book) icon.  Use the down arrow and the path New Page>Import 

File>Append 

 

 
 

6. Locate the file to imported and click open 
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7. The new page(s) will be automatically added to the end of the open document.  Make sure the 
new page(s) pass all the quality control tests.  

8. Click Modify and Save for the page to be added to the original document. 

9. Log out of BDMS. 

Note: You cannot delete a page of documentation once it has been indexed and saved! 
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Appendix 

Preparing an eMail message for import 
You need to save an email as a text file if you want to import it into BDMS.   

From the email, follow the menu path: File >> Save As... 

 

 
 
 

Navigate to the appropriate folder, name the file, and change the Save as type to Text Only.  
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Click the Save button.  

If you did not save this to the USNH\\Louise\JVimages folder then you will need to know where 
you have saved this text file.  

 
 

What do I do about this Unique Key Violation error? 
When you see a Unique Key Violation error message while you are indexing a document, it means 
there is already a document indexed with the same key pieces of information.  

BDMS does not allow more than one document to be indexed with the same key fields, so you have 2 
choices: 1) index with different information, or 2) attach the new document to the document which 
was previously indexed.  

To attach the new document to the document which has already been indexed:  

1. Click the OK button to acknowledge the error.  

 
2. Click the Key Reference & Indexes button to search for other documents saved with the same 

index terms.  

 
3. The documents are displayed in a table where the index terms had been. Scroll to the right to 

see information for the document, to confirm you found the one you’re looking for.  

 
4. Once you find the document you want to add the new pages to, click the Attach to Document 

button.  

 
5. This will attach the single page you’re looking at, to the end of the document which had 

previously been indexed.  

6. BDMS returns you to the regular indexing page, but now anything you attach will be attached 
to the previously indexed document. Continue indexing as you normally would.  
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Search (query) for a document  
To search for a document which has been indexed:  

1. Log into BDMS.  

2. From the Application List, right-click the application (B-F DOCS) and select New Query from the 
menu.  

 
3. The Query Criteria screen appears.  

Note: The index fields you see depend on the application you are in.  

4. Enter the information you wish to search on.  
Note: Use the wild card (*) to search with partial information. Examples:  
Entering J1* in the Document ID field will return all documents that start with “J1”.  
Entering *D65 will return all documents that end with “D65”.  
Entering *4* will return all documents that contain a “4”.  

5. If necessary, click the Range button and enter the appropriate information to search on a range 
of values.  

 
Example:  
Entering Greater than or equal to J0 in the Document ID field will return only the documents 
which begin with “J0”.  

6. If necessary, click the Search List button and enter the appropriate information to search for 
multiple values at once.  

 
Example: 
Entering Smith or Jones in the Last Name field will return documents for anyone whose name is 
Smith or Jones.  

7. If you do not want a particular column to show on the Query Search Results screen, deselect 
the checkbox in the Show column.  

 



 

  Page 29 of 30 

8. Click the Submit button to run the query. 

9. To view a document from the query results, click the Open Document icon.  

 
 

BDMS Finance Application List  
 
 

Application Name Description 
B-F DOCS - BANNER FINANCE PURCHASING A/P Includes the following document types: AP 

ACH, AP CHECK,CHECK,DIRECT CASH 
RECEIPT,ENCUMBRANCES,INVOICE,INVOICE 
PAYMENT,JOURNAL VOUCHER,PAYROLL 
CHECK,PAYROLL DDN,PURCHASE ORDER, AND 
REQUISITION 

B-F-ID – BANNER FINANCE COMMON DEATH CERTIFICATE,PROOF OF 
CITIZENSHIP,CHECK,DIRECT CASH 
RECEIPT,EMAIL,ENCUMBRANCES,JOURNAL 
VOUCHERS 

B-H-ID – BANNER HR COMMON ADVANCE,AFFIRMATIVE ACTION,BENEFIT 
BACKUP DOCS,BENEFIT FORMS,BENEFIT 
FORMS M&D,DEFER PAY,DELETED 
ITEMS,EMPLOYEE AUTH FORMS,EMPLOYEE 
INFO FORM,EMPLOYMENT AUTH 
FORMS,FAMILY STATUS CHANGE,I-9 
FORM,IMMIGRATION DOCS,NAME\ADDRESS 
CHANGE,NRA,PAYROLL SUPPORT,VOLUNTARY 
DEDUCTIONS,W-2, W-4 

 
 

BANNER Document and Form List  
 

Document Type Access from these Banner Forms 
Journal Voucher FGAJVCD, FGAJVCM, FGAJVCQ, FGIJSUM, FGIJVCD 
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Invoice FAAINVD, FAAINVE, FAAONLC, FAAPAYC, FAARUIV, FAIINVE, FAIINVL, 
FAIOINF 
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